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Your Best STL Learning Tools 

Welcome to your Best STL training course. 

As part of your training, we provide you with the following tools and resources to support and 

enhance your learning experience. 

 

Thank you for choosing Best STL. 

 

To guide you through your
training while you are on the
course.

Contains unit objectives,
exercises and space to
write notes.

In-course

handbook1
12 months
access to Microsoft
trainers

3

Available through online 
support forum.

Need help? Our team of
Microsoft qualified trainers
are on hand to offer advice
and support.

Your delegate account
gives you access to:

• Reference material

• Course exercise files
• Advice & support forum
• Rewards programme

• Promotions & Newsletters 

Delegate
account4

Hints and tips available

online from our Microsoft
qualified trainers for:

• All MS Office applications

• VBA
• MS Project
• MS Visio

+ more

Trainer hints
and tips5

Save on further training 
courses you book with 
Promotions.

• 30% off list price
(time limited)

• £50 off list price

(blue card discount)

Save with
Promotions6

Reference

material

Available online through
your delegate account.

Comprehensive reference
material with 100+ pages, 
containing step-by-step
instructions.

2

 

E&OE 

Best Training reserves the right to revise this publication and make changes from time to time in its 

content without notice. 
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Quick reference: Outlook shortcut keys 

Command Keystroke 

Advanced Find Ctrl-Shift-F 

Check for new mail F5 

Close a window Esc 

Create Appointment Ctrl-Shift-A 

Create Contact Ctrl-Shift-C 

Create Flag for follow-up Ctrl-Shift-G 

Create Folder Ctrl-Shift-E 

Create Meeting Request Ctrl-Shift-Q 

Create Message Ctrl-Shift-M 

Create Note Ctrl-Shift-N 

Create Task Ctrl-Shift-K 

Create Task Request Ctrl-Shift-U 

Delete opened item Ctrl-D 

Forward selected mail Ctrl-F 

Mark item as read Ctrl-Q 

Move down one screen PgDn 

Move to first item Home 

Move to last item End 

Move up one screen PgUp 

Create new default item Ctrl-N 

Open “Find a Contact” F11 

Open folder Ctrl-Y 

Open “Look In” Alt-I 

Open selected item Enter 

Redo (in text field) Ctrl-Y 

Remove last semi-colon from mail addressee Alt-K 

Reply to selected message Ctrl-R 

Select all items Ctrl-A 

Select to first item Ctrl-Shift-Home 

Select to last item Ctrl-Shift-End 

Spell check open item F7 

Switch to Inbox Ctrl-Shift-I 

Switch to Outbox Ctrl-Shift-O 

Undo Ctrl-Z 
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Introduction and Overview of Outlook 2007 

 

Outlook provides an integrated solution for managing your time and information. It can 

make it easier to prioritise and control your time, so that you can focus on the things that 

matter most. 

Outlook is much more than an electronic mailbox 

Office Outlook 2007 delivers innovations you can use to quickly search your 

communications, organise your work and share information with others – all from one 

place. 

 

 

Navigation  Pane to move 

around Outlook 

Keep track of daily 

meetings 

Manage & maintain 

your To-Do List 

An electronic rolodex 

for your contacts 
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New Features and Capabilities 

In Outlook 2007, the first time you create a new message (or open one you receive) you'll 

see the Ribbon. It's the band across the top of the window. 

One of the most dramatic changes in Outlook, the Ribbon gives Outlook a new look. But 

as you get up to speed, you'll see that the change is more than visual — it's there to help 

you get things done more easily and with fewer steps. 

And it doesn't end with the Ribbon. There's a lot more that's new to help you work faster and 

more efficiently. To name just a few of these things, there's the To-Do Bar, new navigation 

in the calendar, and a new format for contacts. 

 

Introducing the Ribbon 

 

 

 A new e-mail message. The Ribbon is at the top of the window 

 

The Ribbon is visible each time you create or edit something in Outlook. Specifically, you'll 

encounter the Ribbon when you create or modify e-mail messages, calendar items, contacts, 

tasks, or journal entries. 
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A Closer Look At the Ribbon 

 

To better help you learn how to use the Ribbon - its basic arrangement: 

1. Tabs The Ribbon is made up of different tabs. Here we've shown the Message 
tab. Each tab is related to specific kinds of work that you do in Outlook. 
On the tabs are the commands and buttons that you've used before. 

2. Groups Each tab has several groups that show related items together. Basic 
Text is a group. 

3. Commands The Bold button and the Font list (showing the Calibri font) are 
commands. A command is a button, a box to enter information, or a 
menu. The most commonly used commands, such as the Paste 
command, have the largest buttons. 

The Ribbon Shows What You Need 
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As mentioned earlier, you'll encounter the Ribbon when you take certain actions like creating 

messages, calendar entries, or contacts (to name just a few things you might do in Outlook). 

The Ribbon shows tabs and commands appropriate for what you're doing. That is, the tabs 

on the Ribbon will differ depending on the area of Outlook you're working in. We've 

shown some of these differences in the picture: 

1. A new message shows the Message and Options tabs with groups and commands 
that you'll use when you write and send a message. 

2. A new appointment shows an Appointment tab with groups and commands specific 
to working with a calendar entry. 

3. A new contact shows a Contact tab with groups and commands to help you keep 
contact information up to date. 

 

There's More Than Meets The Eye 

 

A small arrow at the bottom right hand side of a group,  known as a dialogue box launcher, 

means there's more available than what you see. 

For example, to see the full list of font options, you would click the arrow next to the Basic 

Text group on the Message tab of a new e-mail message. 

The Mini Toolbar 

 The Mini toolbar allows you to quickly access formatting commands right where you need 
them: in the body of an e-mail message.  

1. Select your text by dragging with your mouse, and then point at the selection. 

2. The Mini toolbar appears in a faded fashion. If you point to it, it becomes solid, and 
you can click a formatting option. 
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The Quick Access Toolbar 

 

 

The Quick Access Toolbar is a small toolbar above the Ribbon. It's there to make the 
commands you need and use most often readily available. 

What's best about the Quick Access Toolbar? What's on it is up to you. That is, you can add 
your favourite commands to it with a simple right-click.  

You'll see and use different Quick Access Toolbars depending on the area of Outlook that 
you're working in. For example, customizations that you make to the Quick Access Toolbar 
for messages you send will not appear on the Quick Access Toolbar for Contacts. 

Keyboard Shortcuts 

 

Press ALT to see the keyboard shortcuts. Press the indicated key to show the correct tab, 
and then press the letter to access the command you want. 
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Know Your Options 

 

Outlook provides many options to help you change how things look and work. 

Where you set options for all of Outlook, like the standard reminder time for appointments or 
the default location for saving sent messages, hasn't changed. You'll still click Options on the 
Tools menu from within the main Outlook window and use the Options dialog box. But some 
things have changed with options. That's what we'll talk about next. 

More About Options 

 

We just talked about the Options dialog box, but in Outlook 2007 you set options from a few 
different locations. 
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Options for Writing E-Mail 

If you want to change your settings for writing e-mail — for example, to make the spelling 
checker stop ignoring words in uppercase — you do that from the Editor Options dialog box. 
You start by creating a new message, and then: 

1. Click the Microsoft Office Button . 

2. Click Editor Options. 

Note Some settings, such as those that you set in the Personalize area of 
the Editor Options window, are shared among all Office 2007 programs. However, 
most changes that you make in Editor Options will apply only to Outlook. 

Options for Sending E-Mail 

When you send an e-mail message, you can make choices about how that message is 
sent. For example, you can choose whether the outgoing message is formatted in Plain Text, 
HTML, or Rich Text. You can also change where you keep a copy of a particular sent 
message (or you can specify whether you keep a copy of it at all). You'll set these types of 
options from tabs available on the Ribbon for that message.  

The To-Do Bar 

 

Located at the far right of the window, the To-Do Bar is visible wherever you happen to 
be working in Outlook (that is, you can see it from Mail, Calendar, Contacts, and so on). 
The To-Do Bar is there to help you keep track of upcoming tasks and appointments.  In 
the picture, we've called out a few of its key elements:  

1. Date Navigator. 

2. Upcoming calendar appointments. 

3. A place to enter new tasks by typing. 

4. Your task list. 
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A New Look For the Calendar 
 

 

We hope that when you look at the new design of the calendar in Outlook 2007 you'll 
instantly notice that it's easier to see what's what. Moving around is easier too. Here are 
some examples: 
1. Bigger buttons make it easier to quickly switch between daily, weekly, and monthly 

calendar views. 

2. Back and Forward buttons let you quickly go to the next day, week, or month in the 
calendar. 

3. Also new is a Tasks area. You can use this area to track your accomplishments: 
Completed items on this list appear crossed out and "stick" to the day; tasks not 
marked as complete will automatically be carried over to the next day, until you 
complete them. 

A New Look for Contacts 

 

In Outlook 2007, Electronic Business Cards make contacts easy to view and easy to share. 
You'll first notice the new look for contacts when you click Contacts to switch to that area of 
Outlook. 

You can send Electronic Business Cards through e-mail. You might want to include your 
own Electronic Business Card as part of your e-mail signature. 

Tip   Notice also that in this picture the Navigation Pane is minimized to 
show more of the Contacts pane. You can minimize the Navigation Pane from 
any area of Outlook by clicking the Minimize the Navigation Pane button. 
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Unit 1 - Getting Started 

The Outlook Environment 

 

 
 
 
Title Bar Displays the name of the application and the name of the 

current folder. 

Menu Bar Lists available menus 

Ask A Question Box Provides help using Microsoft Office online 

Standard Toolbar Provides quick access to some of the most frequently used 
commands. 

Navigation Pane The column to the left side of the window that provides 
access to all components of Outlook 

Go Menu Part of the Navigation Pane that allows you to quickly 
switch between components. 

Quick Launch Bar Part of the Navigation Pane that provides access to 
frequently used components. 

Reading Pane Displays the contents of the selected messages without 
having to open the message. The status bar displays 
information about the active folder. 

Title Bar Menu Bar 
Help Box 

Standard Toolbar 

N
a

v
ig

a
ti

o
n

  
P

a
n

e
 

Go Menu 

Quick Launch Bar 
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Item An item is a basic element created in Outlook that holds 
information and is stored in a specific location. 

 
Items in Outlook include: 

• Messages 

• Appointments 

• Meetings 

• Contacts 

• Tasks 

• Notes 

Folder A folder is a tool that you can use to store and organise 
Outlook items. 

 
Outlook contains six main components that you can use to communicate with others. These 
components are folders. 

Inbox Where you send and receive messages. 

Calendar Where you schedule appointments, meetings and events. 

Contacts Where you enter and track business and personal contacts 

Task Where you create and manage tasks 

Journal Where you can automatically track all items that you have 
specified as they occur. 

 
Additional Folders in Outlook Include: 

Deleted Items Stores any items that you delete in Outlook. 

Drafts Stores copies of unfinished messages you can complete 
and send at a later time. 

Junk E-Mail Contains junk email messages 

Outbox Temporarily stores messages you send until they are 
delivered. 

Sent Items Stores copies of messages you send to others. 

Sync Issues Contains all of the synchronisation logs 

Search Folders Contains views of all mail items that satisfy specific search 
criteria. 

Compose and Send a Simple Message 

You need to send some important information to a client who is located in another part of the 

country. The client needs the information today. Sending it by regular mail is not an option. 

The client is out of the office, so you can’t call either. 

By using Outlook you can quickly and efficiently send the information in a 

simple message. 
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E-MAIL 
Electronic mail, or E-Mail, is an application that allows a user to create, send and receive 

electronic messages. You can send information and receive information from 

users within your network of computers or outside your network of computers 

via the internet. 

 

The Message Form 

When you create a new message using the ‘New’ button or Ctrl + N, Outlook displays a 

message form that contains text boxes in which you can enter specific information. 

In the new message, you'll need to get oriented to the Ribbon. You'll see the Message tab 

on top, which contains the commands and buttons that you're most likely to use every time 

you create and send a message. 

If you're having trouble finding a command or a button, you may need to look on 

another tab. For example, to insert a picture so that it appears in line with the text of your 

message, (not as a separate attachment), you'll need to switch to the Insert tab. 

Note This isn't completely new, but it's something to be aware of: 

Certain groups and buttons will be available only when the insertion point is in the 
body of the e-mail message. For example, formatting commands on the Basic Text 
tab won't be available when the insertion point is in the To... field or the Subject: 
field; to use those commands, you need to move the insertion point to the body of 
the message. 

 

 
To... Email address or user name of the person to whom you want to send 

the message. 

Cc... E-Mail address or user name of anyone of anyone who you want to 

receive a copy of the message (carbon copy). 

Subject: A brief description of the message 

Message Body The text of the message 

 



   

 

Best STL ©2013 www.microsofttraining.net 17 

 0207 987 3777 

 

 
 
Default Mail Editor 
 
Microsoft Word is the default mail editor for Outlook. Therefore, when you create mail 

messages you will have access to a number of Word features, making it easier to create 

messages in Outlook. 

E-Mail Etiquette 

 
Net etiquette or Network etiquette is a set of guidelines for ethical behaviour on the 

internet, including sending and receiving e-mail. You can become a responsible internet user 

by applying the simple guidelines to your own e-mail activity: 

 Think twice before clicking the ‘Send’ button. 

o Once you send an e-mail, you might not be able to take it back. 

o Realise that an e-mail message can be easily circulated (forward, print and 

distributed) 

 Be cautious with humour and sarcasm 

o Statements that are funny person to person might lose their humour in writing and 

appear, instead, confusing or even vicious. 

 Use CAPITAL LETTERS sensibly. 

o Statements in Capitals can suggest you are shouting at the reader. It may also be 

used to highlight important points. 

Use the Address Book to Add Recipients 

 
 

You'll find the Address Book command on the Message tab, OR Click the ‘To’ button (below 
the ribbon.) 
 



   

 

Best STL ©2013 www.microsofttraining.net 18 

 0207 987 3777 

 

The Address book is a collection of address books or address lists that you can use 

to find and select names, email addresses and distribution lists to quickly address 

messages. 

Global Address List 
 
The Global Address List is a list of all user names and global distribution lists in a 

particular organisation that is created and maintained by the Microsoft Exchange 

Server Administrator. You can only access the Global Address List if you are using a 

Microsoft Exchange Server email account. 

Show or hide the Bcc field 

 
 
If you prefer to type e-mail addresses directly in the To and Cc boxes, you may also want to 

know how you can show the Bcc (blind carbon copy) field so that you can type names there, 

too. (You can use Bcc to send messages without exposing the names of the recipients 

to each other — it's one way to respect the privacy of the people to whom you're 

sending e-mail.) 

You will find the ‘Show Bcc’ command under the ‘Options’ tab. 

Include Your Signature 

 
You can modify existing signatures or create new ones, as well as set a default 

signature, by clicking the arrow under the Signature command. 
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1. If you created signatures previously, you'll see them listed here. 

2. To create new signatures, set a default signature, or modify existing signatures, click 
Signatures... 

Format a Message 

You need to send a message that contains important dates and times for some upcoming 

events. You want to make sure that the dates and times stand out in the message text. By 

formatting specific text in a message, you will emphasise that text, drawing the 

reader’s attention to it. 

Select the text that you want to emphasise. (To select all the message text, press Ctrl +A) 

Apply the format 

Under the ‘Message’ tab in the ‘Basic Text’ group you can find most of the formatting tools 

required. 

Save Message 

While composing a message, you might decide that you are not ready to send the message. 

You can save a message and send it at a later time by clicking on the ‘Office Button’ 

and selecting save. 

The message is stored in the ‘Drafts’ folder. When you’re ready to finish the message, 

simply select from the drafts folder and continue. 

Checking Spelling and Grammar 

 
Whenever you’re typing, there’s always the possibility of making an error. For example you 

know the correct spelling of the word “their”, but you type it as “thier”  

When you are trying to convey a professional image, misspelled words and incorrect 

grammar can make you look unprofessional. 

AutoCorrect 
 
The AutoCorrect feature detects common typing mistakes, including misspelled words, 

grammar problems, incorrect capitalisation and common typos. AutoCorrect brings them to 

your attention. By default, the AutoCorrect feature is on. 
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Unit 2 - E-Mails 

Attach a File 

 
You have some information in a separate file that you want to include in a message.  

Re-typing that information in the message will take some time. You can’t copy and paste the 

information because it’s in a different format. By attaching the file to your message you 

can include the additional information without wasting time. 

 

 
 
Where you'll find Attach File 
 
Because including an attachment is such a common activity, Attach File is available from 

both the Message tab and the Insert tab. 

File Type and Size 
 
There are a few file type and size guidelines you should follow before attaching files or items 

to an Outlook item. 

 Make sure the recipient of an attachment will be able to open and read the 

attachment. The recipient must have the application in which the attachment was 

created or a similar application. 

 Be aware of attachment size as a large attachment will use a lot of space and might 

delay the opening of the item to which it is attached. 
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Include a picture in line with text 

 

 

In Outlook, it's easy to send pictures in line with the text of your e-mail messages 

instead of as separately attached files. To do this, you would: 

1. Click the Picture command located on the Insert tab. 

2. When you insert a picture this way, you'll see a picture in line with the text of the 
message as we've shown here. 

Note When you insert a picture into your message, you add it to the message 
as an embedded object. That is, it is a part of the message text. To be able to see 
the picture, people who receive your message must be able to receive HTML or 
Rich Text messages. 

Tabs that come and go (known as contextual tabs) 
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Some tabs appear only when you do specific tasks. 

For example, when you: 

1. Select a picture that you have inserted into a message… 

2. …you'll see that Picture Tools appear on the Ribbon. 

3. The Format tab includes commands that you can use to edit the picture before you 
send it. 

When you click away from the picture, Picture Tools disappears. 

You'll see similar behaviour if you include a chart, drawing, diagram, or table in your 
message. 

Respond to a message 

  

E-mail isn't just about sending… it's also about receiving and replying. When you reply 
from an open message, you'll use the buttons in the Respond group on the Message tab of 
the Ribbon. 

You'll notice that what's on the Ribbon in a received message is different from what's on it 
for a new mail message. 

Reply Options 

When you want to reply to a message, you have a few options: 

Reply To send a response to the sender of the message. 

Reply to All Send a response to the sender and copies of the response to 
anyone who received the original message. 

Forward Forward a copy of the message to someone who did not receive 
the original. 

The InfoBar  The InfoBar displays information about what has occurred or what 
action you need to take. It is displayed below the active toolbar. 
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Whoops! Need to recall a message? 

 

 
Suppose you've just clicked Send and you realize that a key detail in your message 
is wrong (for example, maybe you wrote "bored" instead of "board" when discussing 
the results of the last board meeting). 

If you're using Microsoft Exchange Server for your e-mail, you may be able to recall 
the message that you just sent. If you act before a recipient reads the message, recalling 
it will allow you to send a corrected version to that person and avoid possible 
embarrassment. Here's what you would do: 

1. In the Navigation Pane, click Sent Items to switch to that folder. 

2. In the Sent Items folder, double-click the message that you want to recall to open it. 

3. In the open message, click Other Actions in the Actions group, and click Recall 
This Message. 

Note If you don't see the Recall This Message command, it's probably 
because you're not using Microsoft Exchange Server for your e-mail. 

Forward a Message 

You received a message from a co-worker that you want to share with another co-worker 

who didn’t receive the original message. By forwarding the message, you can quickly and 

easily share the information. The only information you need to enter is the recipient’s e-

mail address. 



   

 

Best STL ©2013 www.microsofttraining.net 24 

 0207 987 3777 

 

Print a Message 

Although an advantage of email is that it doesn’t require paper, there will be occasions when 

you will want to have a hard copy of a message, either one you’ve sent or one you’ve 

received. 

1. Open the message you want to print 

2. Click the ‘Office Button’ and select Print to display the print dialogue box 

3. To increase the number of copies you want to print, in the Number of Copies spin 
box, click the up arrow as needed to enter the appropriate number of copies. 

4. If necessary, modify the desired print options 

5. Click ‘Print’  

Delete a Message 

 
You have been using Outlook for a while, so your Inbox contains a lot of old messages that 

you no longer need.  By deleting those old messages your Inbox will be less cluttered 

and you will save space on your hard drive. 

To delete a message 

 With message selected or opened click the ‘Delete’ button on under the ‘Message’ 

tab or the ‘Delete’ button on the keyboard or right click and select delete. 

Recover a Deleted Message 

 Drag the message from the deleted items folder to any other folder. 
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Unit 3 - Managing Mail 

 
Your mailbox is overflowing. There are many messages you’ve received and want to keep 

yet others you no longer need. It’s becoming more difficult to find certain messages. By 

organising your mailbox, it will be easier to retrieve information efficiently. 

Preview attachments before you open them 

 

 
In Outlook 2007, you'll receive attachments just as you did in earlier versions of Outlook. 

And now, some attached files can be previewed right from the Reading Pane.  

Suppose that someone sends you two Microsoft Office Visio diagrams as attachments, but 

you only care about the one that shows the new training room in your building. 

How could you quickly decide which file to open or save to your hard disk? 

To preview an attachment, click its icon. The attachment preview appears in the 

Reading Pane. 

Attachment previewing allows you to display previews of certain file types right from the 

Outlook Reading Pane. You can do this without having to open the attached files. 

Note To help keep your computer safe, embedded code in attachments is 
disabled while previewing. 

Once you've decided an attached file is one that you want to open or save, you can do 
that by right-clicking its icon in the Reading Pane. 
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How others receive attachments that you send 

 

 
 

How others receive attachments that you send has not changed. What has changed is the 

file format used by some 2007 release programs such as Word 2007 (now .docx), 

PowerPoint 2007 (now .pptx), Excel 2007 (now .xlsx), and Access 2007 (now .accdb). 

This new format keeps file sizes smaller and helps keep files safer. Attachments that 

you send or receive may use this new format. Outlook fully supports sending and receiving 

files that use the new formats 

How others can view attachments that you send 
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Others can download a compatibility pack so that they can open, edit, and save 

documents that use the new Microsoft Office file formats. 

 

Maybe you're the first person in your workgroup to get the 2007 Office system. Or 

perhaps you work with some departments who need to use Office documents saved in 

an earlier format. You can still share documents with each other. Here's how: 

 

You can open a file created in previous versions of Office, from 95 through 2003. Just 

open the file as usual. After working with it in the 2007 version, you may want to save the file. 

By default, the Save As dialog box saves a file created in a previous version as that 

same version. As you save, a Compatibility Checker will let you know of any new features 

added to the file that may be disabled, or matched as closely as possible. 

 

Note  If you open a presentation created in PowerPoint 95, PowerPoint will 
default to the 2007 format when you save it. But you can choose to save the file in 
the 97-2003 formats. 

If you want to save the file in the 2007 format, select Word Document, Excel Workbook, or 

PowerPoint Presentation in the Save as type box. 

Colleagues who have Word, Excel, or PowerPoint versions 2000 through 2003 (and the 

latest patches and service packs) can open 2007 files. When they click on your document, 

they will be asked if they want to download a converter that will let them open your document.  
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Use Flags and Reminders 

You receive a message that contains information that you will need to refer to in a few weeks. 

Because you have so many other messages in your Inbox, you’re concerned that you will 

forget to revisit that particular message at the appropriate time. 

By flagging the message it will stand out, drawing attention to it. The flag will ensure 

that the message is easy to find and is a reminder to refer back to the message. 

 

Flags and reminders can help you and others remember to do things.  

To add a flag or a reminder (or both) when you're creating a message, start by clicking 

Follow Up in the Options group of a new e-mail message. 

Follow Up for Yourself 

Suppose you send a message to a colleague that says "I'll follow up with you tomorrow." 

To be sure that you remember to do that, flag the message for yourself by clicking 

Follow Up and then clicking Tomorrow. The message (which is moved to the Sent Items 

folder once you send it) is flagged and added to your To-Do List in Tasks list. It also 

shows up as an item on your own To-Do Bar. 

Follow Up for the Recipient 

You can also attach a follow-up flag for your recipients by using the Flag for Recipients 

command. Before you send the message, you specify when you want the recipient to 

be reminded to follow up with you. 

The received message will include a flag and the bell icon (indicating that the message 

includes a reminder). As long as the recipient keeps the message in his or her Outlook 

mailbox, a reminder will be displayed at the time you specify.  

Note  The item will NOT be added to the recipients To-Do Bar — creating a 
to-do list is a matter of personal choice.) 
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Mark a Message as Unread 

You can manually change the status of a message from read to unread. 

1. In the Inbox select the message you want to mark as unread 

2. Choose ‘Edit’ and select ‘Mark As Unread’ 

3. In the Inbox, the message is now bold and has a closed envelope symbol, indicating 
an unread message. 

Automatically Mark Messages as Read in the Reading Pane 

1. Select the ‘Tools’ menu and click ‘Options’ 

2. Select the ‘Other’ tab 

3. Click ‘Reading Pane’ 

4. Select the ‘Mark items when read when viewed in the Reading Pane’ check box and 
then type a number in the Wait n seconds before marking item as read box 

Create a Folder 

If necessary, click the Mail button on the navigation pane to display the mail folders 

If you want the new folder at the top level, right-click Personal Folders, (or whatever 

name you have assigned to the top level) select New Folder from the context menu. 

Otherwise, right-click the folder that you want the new folder in, select New Folder from 

the context menu. 

1. Outlook displays the Create New Folder dialog box. The location for the new folder is 
shaded in the folder display. 

2. You can, if necessary, change the location at this point 

3. Type the name of the new folder in the Name box 

4. Make sure that Mail and Post Items is selected in the Folder Contains list 

Copy Messages to Folders  

You might receive messages that contain information on more than one subject. It 
would make organising more efficient if you could save those messages in more than one 
folder. 
1. Select the message you want to copy 

2. Select the ‘Edit’ menu and choose ‘Copy’ 

3. In the ‘All Mail Folders’ Pane select the folder to which you want to copy the message. 

4. Select the ‘Edit’ menu and choose ‘Paste’ to paste the copied message to the 
selected folder.  

Delete a Folder 

1. In the ‘All Mail Folders’ pane, select the folder you want to delete. 

2. On the Standard Toolbar click the ‘Delete’ button. 

3. In the message box, click ‘Yes’ to confirm the deletion of the selected folder. 
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Unit 4 - Scheduling Appointments 

You have discovered how Outlook helps you to communicate electronically and manage 
those communications. You can also keep your schedule organised electronically by 
using the calendar. 

Your paper calendar is a mess. You’ve scheduled, re-scheduled and cancelled 
appointments. There are scribbled notes posted on certain days as reminders. By using the 
Outlook calendar your schedule will always be up to date and easy to read. 

The Outlook Calendar 

Before you use the calendar you will need to become familiar with its components and how 
they work. By understanding the basics of the calendar you will have a solid foundation upon 
which to build more critical skills. 

  
 

You can schedule activities in your Outlook calendar as appointments, meetings, events, 
or tasks.  

Your choice of entry type will depend on who else is involved and how you want the entry to 
appear.  

By selecting entries in your calendar correctly, you'll know at a glance what's going on, when, 
and with whom. 
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See Your Calendar 

 

 
 

Before you can see what's in your calendar, you need to know how to find it. Here are two 
quick ways to see the calendar: 

 Click Calendar in the Navigation Pane.  

 Click a date on the Date Navigator (which you'll find at the top of the To-Do Bar).  

 

Once you're looking at your calendar, you can use the buttons at the top of the window to 
navigate and to show or hide detail: 

1. Click Day, Week, or Month to quickly switch views. 

2. Forward and Back buttons allow you to easily move through your calendar. 

3. More buttons let you show or hide days or detail, depending on your view. 
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Know Your Choices 

 

A day in the calendar with each type of entry occurring once. 

1. Appointment:  An appointment is an activity that involves only you, at a scheduled 
time. 

2. Meeting:  A meeting occurs at a scheduled time, like an appointment. The 
difference is that you invite other people by using a meeting request 
that's sent via e-mail. 

3. Event:  An event is an activity that lasts all day long. Unlike an appointment 
or meeting, an event doesn't block out time in your calendar. With an 
event, you can still have other entries appear in your schedule for that 
day. 

4. Task:  A task is an activity that involves only you, and that doesn't need a 
scheduled time. New to Outlook 2007 is an area in your calendar's 
Day and Week views that shows tasks. 

Just You? Use an Appointment 

Appointments are activities that you schedule in your calendar that do not involve inviting 
other people or reserving resources. You can schedule recurring appointments, view 
your appointments by day, week, or month, and set reminders for your appointments. 

You can specify how the appointments in your calendar look to others by designating 
the time of the appointment as busy, free, tentative, or out of office. Also, others can give 
you permission to schedule or make changes to appointments in their calendars. 
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Create an Appointment 

1. On the File menu, point to New, and then click Appointment.  

2. Keyboard shortcut to create an appointment, press Ctrl + Shift + A. 

3. In the Subject box, type a description.  

4. In the Location box, type the location.  

 

5. Enter the start and end times.  

 

Tip  You can type specific words and phrases in the Start time and End 
time boxes instead of dates. For example you can type Today, Tomorrow, New 
Year’s Day, Two Weeks from Tomorrow, Week from Yesterday, Three days 
before New Year's Day, and most holiday names. 

 

6. Select any other options that you want.  

7. To make the appointment recur, on the Appointment tab, in the Options group, click 

Recurrence .  

8. Click the frequency (Daily, Weekly, Monthly, Yearly) with which the appointment 
recurs, and then select options for the frequency.  

 

9. Click OK.  
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10. On the Appointment tab, in the Actions group, click Save & Close. 

One quick way to start an appointment (or any calendar entry, for that matter) is to rest 
the pointer over the desired time in Day view, click, and type the details. We've shown the 
steps to do this in the picture: 

 
 
11. Rest the pointer over the desired time in your calendar and click. 

12. Type the details. 

13. Need more time for your appointment? Simply drag the handle to make the 
appointment    longer. 

 

Assign a Colour Category To a Calendar Appointment 

You can track all items related to a particular project or task by using colour 
categories to easily identify and organize the items. Besides calendar items, you can 
assign colour categories to contacts, messages, tasks, notes, and journal items. 

Colour categories connect your calendar items for easy identification. The colour 
categories connect you to other related items too, such as messages or contacts. 
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A category must be listed in the colour category list before you can assign it. If it is not listed, 
you can simultaneously create a new colour category and assign it to an item for the first 
time. You can also choose from several default colour categories and rename them to be 
more meaningful to you. 

To assign a colour category, do the following: 

 For an appointment in Calendar 

o Right-click the appointment, point to Categorise , and then click a colour 

category.  

 For an open appointment 

o On the Appointment tab, in the Options group, click Categorise , and then click 

a colour category.  

 For an open meeting request 

o On the Meeting tab, in the Options group, click Categorise , and then click a 

colour category.  

 For a open recurring meeting request 

o On the Recurring Meeting tab, in the Options group, click Categorise , and 

then click a colour category.  

To see more categories or to create a new category 

Click All Categories to open the Colour Categories dialog box. To assign a colour category 
from the Colour Categories dialog box, you must select the check box next to the colour 
category. The Colour Categories dialog box is also a quick way to assign multiple categories 
to an item. 

The first time that you assign a default colour category to an item, you will be prompted to 
rename the category. At this time, you can also change the colour of the category and 
choose a keyboard shortcut. 

Note You can change the colour associated with a category at any time.  

Another way to open the Categorise menu and Colour Categories dialog box is by clicking 

Categorise on the toolbar.  

Only the 15 most recently used colour categories appear on the Categorise menu. To see 
the rest, click All Categories on the Categorise menu. 
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Change an appointment 

Open the appointment, event, or meeting that you want to change.  

Do one of the following:  

1. Change options for an appointment that is not part of a series 

a. On the Appointment tab, change the options, such as subject, location, and 
time that you want to change, and then click Save and Close.  

2. Change options for all items in a series 

a. In the Open Recurring Item dialog box, click Open the series.  

 

b. On the Appointment tab, change the options, such as subject, location, 
and time that you want to change.  

c. To change recurrence options, on the Appointment tab, in the Options group, 
click Recurrence. Change the options, such as time, recurrence pattern, or 
range of recurrence, and then click OK.  

 

3. Click Save and Close.  

4. Change options for one item that is part of a series 

a. In the Open Recurring Item dialog box, click Open this occurrence.  
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b. On the Appointment tab, change the options, such as subject, location, 
and time, that you want to change, and then click Save and Close 

Tip  In Calendar, you can drag the appointment, event, or meeting to a 
different date. You can also edit the subject by clicking the description text and 
typing your changes.  

You can change an event into an appointment, causing the time to be blocked out in your 
calendar, by clearing the All day event check box and then entering the start and end times 
of your choice.  

Events are defined as lasting from midnight to midnight; clearing this check box allows you 
to enter specific start and end times. 

Deleting Appointments 

1. Select ‘View’ menu, choose ‘Current View’ and click ‘Category’ 

2. Click ‘Subject’ column heading 

3. Select appointment entries to delete (hold down Ctrl to select more than one item) 

4. Right click and delete or Delete on toolbar or delete on keyboard. 
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Unit 5 - Scheduling Meetings 

You need to schedule a department meeting. You must notify all employees, reserve a slide 
projector and determine who will be attending. 

By using Outlook, you can electronically communicate and track attendance of 
participants and resources at meetings from one central location. 

Schedule a Meeting 

When you scheduled appointments that involve your schedule only, all you had to do was 
enter the information in your calendar. 

Now, you will combine two of the tasks you’ve already learned – sending mail 
messages and scheduling appointments – to schedule meetings that involve multiple 
participants. 

You need to schedule a department meeting. You could invite the participants by phone but 
that will take some time, especially if someone is not available at the designated time. By 
scheduling a meeting in Outlook you can quickly invite the appropriate participants and 
resources all at the same time and you can pick a time that is convenient for everyone. 

The Meeting Scheduling Process 

1. The process begins with a Meeting form that you complete and send to all the 
meeting participants. 

2. The meeting is scheduled on your calendar as soon as you send the meeting form. 

3. As each participant accepts or tentatively accepts the meeting, it is inserted into 
their calendar and a response is sent to the meeting organiser. 

4. If the meeting is declined or a new time proposed a reply is sent. 

The Meeting Form 

The meeting form is used to invite participants to a meeting. It consists of three tabs: 

 The APPOINTMENT tab 

o Allows you to enter a subject, a location for the meeting, start and end times and 

any other information regarding the meeting. 

 The SCHEDULING tab 

o Allows you to co-ordinate the meeting fit the schedules of all attendees. 

 The TRACKING tab 

o Displays the meeting participants and their replies. This section is not visible until 

the meeting form is sent to the participants. 
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Meeting Resources 

A Meeting Resource is an item with its own e-mail account on the Microsoft Exchange 
Server that you can use to schedule for a meeting. It will automatically accept or reject 
meeting invitations. 

 

Schedule an In-Person Meeting 

1. On the File menu, point to New, and then click Meeting Request.  

a. Keyboard shortcut. CTRL + SHIFT + Q. 

2. In the Subject box, type a description.  

3. In the Location box, type a description or click Rooms to choose from rooms 
available for automatic scheduling by using Microsoft Exchange.  

4. In the Start time and End time lists, select the start and end time for the meeting. If 
this is an all day event, select the All day event check box.  

5. An all day event is a full 24 hour event lasting from midnight to midnight. 

Note By default, the current time zone setting on your computer system is 
used to schedule meetings. If you want to schedule meetings based upon an 
alternate time zone, on the Meeting tab, in the Options group, click Time Zones. 

6. Type any information that you want to share with the recipients, attach any files, or 
create a Meeting Workspace. 

7. On the Meeting tab, in the Show group, click Scheduling Assistant.  

a. The Scheduling Assistant helps to find the best time for your meeting. 

8. Click Add Others, and then click Add from Address Book.  

9. In the Select Attendees and Resources dialog box, in the Search box, enter the 
name of a person or resource that you want to invite to the meeting. If you are 
searching with the More Columns option, then click Go.  

10. Select the name from the results list, click Required, Optional or Resources, and then 
click OK.  

a. Required and Optional attendees appear in the To box on the Meeting tab, 
and Resources appear in the Location box. 

b. The free/busy grid shows the availability of attendees. A green vertical line 
represents the start of the meeting. A red vertical line represents the end of 
the meeting. 
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The Suggested Times pane locates the best time for your meeting, which is defined as the 
time when most attendees are available.  
 
The best meeting time appears at the top of the pane. To select any of the suggested times, 
click the time suggestion in the Suggested Times pane. You can also manually pick a 
time on the free/busy grid. 

 

11. If you want to make the meeting recur, on the Meeting tab, in the Options group, 
click Recurrence, select the recurrence pattern, and then click OK.  

12. When you add a recurrence pattern to a meeting request, the Meeting tab changes 
to Recurring Meeting. 

13. On the Meeting tab, in the Show group, click Appointment.  

14. Click Send.  
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Reply To a Meeting Request 
You receive a meeting invitation from a co-worker. You could call her and tell her that you 
will be attending but what if she (or you) forgets to document your participation? 

 

By using Outlook to reply to a meeting request, the meeting organiser will be assured 
of your attendance and it will also be documented in your calendar. 

ACCEPT  

1. Open the meeting request. 

2. Click ‘Accept Proposal’ 

3. Click ‘Send Update’ 

DECLINE 

1. Open meeting request 

2. On the ‘Meeting Response’ tab, in the ‘Respond’ group, click ‘Reply’, type your 
message and the click ‘Send’. 

3. In the meeting request, on the ‘Meeting Response’ tab, in the 'Action’ group click 
‘Delete’. 

Meeting Conflicts 

When you open a meeting request for a meeting that conflicts within another appointment in 
your calendar, Outlook alerts you by displaying a warning InfoBar. 

Conflicting meetings are displayed adjacent to each other on the calendar. 

PROPOSE NEW MEETING TIMES 

You receive an invitation to a meeting which you need to attend but you are not available at 
the scheduled time. 

You could decline the invitation and compose a new message suggesting an alternate 
meeting time. To save time you could propose a new meeting time for the meeting. 

 
1. In the open meeting request, on the Message tab, in the Respond group, click 

Propose New Time.  

Note If you open the meeting from your calendar, on the Appointment tab, in 
the Respond group, click Propose New Time. 

2. Click either Tentative and Propose New Time or Decline and Propose New Time.  
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3. Click a time when all invitees are available.  

 
 

4. Click Propose Time.  

5. Click Send.  

Microsoft Office Outlook 2007 sends a default message saying that you want to 
propose a new time but you have tentatively accepted the meeting. You can 
change this default message to say that you want to propose a new time, and that 
you are declining the meeting: 

6. On the Tools menu, click Options, and then click Calendar Options.  

7. In the Use this response when you propose new meeting times list, click the setting 
that you want.  

Note You can also change this setting for individual meetings. In the open 
meeting request, on the Message tab, in the Respond group, click either 
Tentative and Propose New Time or Decline and Propose New Time. If you 
open the meeting on your calendar, on the Appointment tab, in the Respond 
group, click either Tentative and Propose New Time or Decline and Propose 
New Time. 
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Track Meeting Responses 

You have a department meeting scheduled for tomorrow. You need to determine exactly 
how many people will be attending so you can make the necessary preparations. 

By using Outlook, you can quickly track who has responded and who has not 
responded to the meeting request. 

Display the Calendar 

1. Display the date on which the meeting is scheduled. 

2. Double click the meeting to open the meeting form 

3. Select the ‘Tracking’ tab. 

 

Update a Meeting Request 

You have a meeting on the wrong day. You intended for the meeting to be on a Monday 
rather than a Tuesday. 

You could send cancellation notices and new meeting invites but that will require a lot of 
work on your part and generate a lot of mail for all the attendees of the meeting. 

An easier and quicker solution is to reschedule the meeting by updating the meeting 
request. 

1. Open the Meeting Form 

2. Make the appropriate changes 

3. Send Update To Attendees 

Cancel a Meeting Request 

You have a meeting scheduled for tomorrow. A large number of participants are attending. 
You have a conflict, so you’re going to have to cancel the meeting. 

You don’t have time to call everyone. Luckily, you can use Outlook to quickly solve your 
problem. When you cancel a meeting in Outlook, each participant is automatically 
notified. Therefore, you won’t have to worry about a participant turning up for a meeting that 
has been cancelled. 

In addition, participant’s calendars will be cleared so they can attend other potential 
meetings instead. 

The only person who can cancel a meeting is the meeting organizer. The meeting 
organizer is the person who sets up the meeting by choosing who to invite and sending the 
meeting request to those people. As an organizer, you can cancel a one-time meeting, a 
recurring meeting, or one or more instances of a recurring meeting. 
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Cancel a One-Time Meeting 

1. In Calendar, open the meeting.  

2. On the Actions menu, click Cancel Meeting.  

Important  If Cancel Meeting is not on the Actions menu, you are not the 
meeting organizer, and you can't cancel the meeting. 

3. Click Send cancellation and delete meeting 

Cancel a Recurring Meeting 

1. In Calendar, open the meeting.  

2. In the Open Recurring Item dialog box, click Open the series, and then click OK.  

3. On the Standard toolbar, click Recurrence.  

Important  If Recurrence is not on the Standard toolbar, you are not the 
meeting organizer, and you can't cancel the meeting. 

4. Under Range of recurrence, click End by, select the date that you want the meeting 
to end, and then click OK.  

Note By changing the end date of the recurring meeting, the instances of the 
meeting that have already occurred stay on the attendees' calendars. 

5. On the Standard toolbar, click Send Update. 

Cancel An Instance Of a Recurring Meeting 

1. In Calendar, open the instance of the recurring meeting.  

2. In the Open Recurring Item dialog box, click Open this occurrence, then click OK.  

3. On the Actions menu, click Cancel Meeting.  

Important  If Cancel Meeting is not on the Actions menu, you are not the 
meeting organizer, and you can't cancel the meeting. 

4. In the Confirm Delete dialog box, click Delete this occurrence.  

Note If you are a meeting attendee — that is, if the organizer invited you to 
the meeting —you can only decline the meeting or, if allowed by the organizer, 
propose a different meeting time.  
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Whether you cancel or delete a meeting, make sure that you click Send cancellation and 
delete meeting, and then send the cancellation to everyone you invited. It is poor meeting 
etiquette — not to mention inconsiderate — to cancel a meeting without notifying the people 
you invited. 

Print the Calendar in Outlook 

You are going to be out of the office on business. You have a number of meetings 
scheduled while you are away but you won’t have your laptop with you. 

By printing a copy of your calendar before you leave you won’t have to worry about missing 
a meeting. 

 

With the calendar open: 

1. Select the ‘Office Button’ and choose ‘Print’ 

2. From the Print Style List box select ‘Calendar Style’ 

3. In the Print Range box, specify the Start Date 

4. In the Print Range box, specify the End Date 

5. If necessary select other Print Options 

6. Click ‘Print’ 
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Unit 6 - Managing Contacts 

You have quite a collection of business cards; however, that fax number you need in a hurry 
always seems hard to find. 

Outlook makes it easy to organise all the information you need about your business 
and personal associates. Names, addresses and phone numbers are easy to search and 
easy to retrieve and update. 

Add a Contact 

Because an external client does not work for your company, his e-mail address is not in the 
Global Address List. Every time you send him a message you have to type his e-mail 
address which is, georgemesserschmidt@msmoveandstore.com You have on several 
occasions misspelled the e-mail address, therefore, having the message bounce back as 
undeliverable. 

By adding George’s e-mail address to Outlook once, you can quickly retrieve it whenever 
you need it, saving typing time and on undeliverable messages. 

Contacts 

A Contact is a person with whom you communicate on a business or personal level and 
whose personal or business (or both) information is stored in the Contacts Folder. 

The Contact Form 

When you create a new Outlook contact, Outlook displays a Contact form that contains tabs 
and text boxes in which you can enter personal and business information. 

The Outlook Address Book 

The Outlook Address Book is a list that contains all contacts that you create by using the 
Contact form. 
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In Office Outlook 2007, each of your contacts is also displayed as an Electronic 
Business Card which is a view of specific information about a contact, in a format similar to 
a paper-based business card, that can be inserted into messages. Any information that you 
add to a contact is automatically made to the corresponding Electronic Business Card, and 
vice versa. 

 

 
 

1. A contact form that contains Jon Morris's information. 

2. A view of the Edit Business Card dialog box, with the corresponding fields filled in for 
Jon Morris's Electronic Business Card. 

Create a Contact 

1. On the File menu, point to New, and then click Contact.  

a. Keyboard shortcut - Ctrl +Shift +C 

2. Type a name for the contact.  

3. Enter the information that you want to include for the contact.  

4. Save and Close. 

Note To specify how you want the contact's name to appear in the To... line 
of a message, type a name in the Display As box.  

To enter multiple entries for a field, such as more than one phone number or e-mail address, 
click the down arrow next to the field.  

If you have more than one mailing address for a contact, select the 'This is the mailing 
address check box' to establish which address is to be used during a mail merge. 

 

Tip  You can quickly create another contact with the same company 
information. In the current contact, on the Actions menu, click New Contact from 
Same Company. 



   

 

Best STL ©2013 www.microsofttraining.net 48 

 0207 987 3777 

 

Create a contact from another contact 

You can create a new contact from an existing contact by using the existing contact as a 
template, and then changing any of the information, as necessary. 

1. In Contacts, in Business Cards view, click the contact that you want to use as a 
template.  

Note You can also complete this procedure in the Address Cards and 
Detailed Address Cards views.  

2. Press CTRL + C, and then press CTRL + V.  

3. In the Duplicate Contact Detected box, select the Add new contact option.  

4. When you save a contact or an Electronic Business Card (Electronic Business Card: 
A view of specific information about a contact, in a format similar to a paper-based 
business card, that can be inserted into messages.) with the same name or e-mail 
name as one that already exists in your Contacts folder,  

Note  Microsoft Office Outlook displays a dialog box with options to either add 
the duplicate contact as a new contact or update the existing contact with the new 
information from the duplicate contact. 

5. Click Add.  

6. The new contact will appear in Business Cards view next to the contact you copied. 

7. Double-click the new contact to open it, and then edit the information, as needed.  

8. Click Save and Close. 

Create a contact from an e-mail message that you receive 

1. Open or preview the e-mail message that contains the name that you want to add to 
your contact list. 

2. Right-click the name of the sender who you want to make into a contact, and then 
click Add to Contacts on the shortcut menu. 

Note In Outlook, there is no option to add contact information automatically to 
Contacts or Address Book when you reply to a contact.  



   

 

Best STL ©2013 www.microsofttraining.net 49 

 0207 987 3777 

 

Create a contact from an Electronic Business Card that you receive 

When you save an Electronic Business Card received in an e-mail message, you create a 
new contact. If you already have a contact by the same name, you can save the duplicate as 
a new contact or update the original. 

1. In an open message, right-click the card, and then click Add to Contacts on the 
shortcut menu. The new contact opens in the contact form.  

a. On the Contact tab, in the Save group, click Save & Close.  

2. If you already have a contact with the same name, Outlook detects the duplicate. Do 
one of the following:  

a. Select Add the new contact. This creates a duplicate contact, including a 
contact form and Electronic Business Card.  

b. Select Update the information. Existing duplicate contacts are listed. 
Double-click the contact to update it, and then update the information on the 
contact form and save it. 

Note The new contact information is now saved in Contacts and is available 
as an Electronic Business Card as well as in other views. You can make changes 
to the contact information both before and after you save it. To make changes to 
the card after you save it. 

 

Note You can also right-click the attached .vcf file in the message header to 
open the shortcut menu and add the contact or choose other options.  

If you click the Save & New option in the contact form, the open contact is saved, and a new, 
blank contact form opens. 

Edit a Contact 

Contact information changes frequently. Whether it’s an updated address or phone number. 
Outlook puts an end to messy address books or card files. Your contact information will be 
neat and easy to read. 

1. Open the Contact form  

2. Double click the contact or right click and select Open 

3. Edit the appropriate information 

4. Save and Close 
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Delete a Contact 

Your address book contains a number of contacts with whom you no longer do business. 

By deleting those old contacts your address book will be less cluttered and you will save 
space on your hard drive. 

1. Select the contact 

2. Delete button on toolbar OR 

3. Right click and select ‘Delete’ 

Print Contacts 

1. Select the ‘Office Button’ and choose ‘Print’ 

2. From the Print Style List box select a print style 

3. If necessary select other Print Options 

4. Click ‘Print’ 

Create a Distribution List 

A distribution list is a named collection of contacts.  

It provides an easy way to send e-mail messages to a group of people. For example, if 
you frequently send messages to the marketing team, you can create a distribution list — 
called "Marketing Team" — that contains the e-mail addresses of everyone on that team. A 
message sent to this distribution list goes to all recipients listed in the distribution list.  

You can include distribution lists in messages, task requests, meeting requests, and even in 
other distribution lists. 

Distribution lists are stored by default in your Contacts folder. If you use a Microsoft 
Exchange account, your can contain global distribution lists, which are available to everyone 
who uses that network.  

The personal distribution lists that you create in your Contacts folder are available only to 
you, but you can share them by sending them to others. 

How many names can I include in a Distribution List? 

The maximum number of names that you can include in a distribution list depends on the 
size of the contact files (for each contact) themselves. There are no hard and fast rules but 
in general, a distribution list can contain between 50-70 names and e-mail addresses. A 
maximum number of e-mail addresses, with minimum contact file size, is approximately 125, 
and this can include other distribution lists 
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Do one of the following: 

Create a distribution list by using names in the Address Book  
 
1. On the File menu, point to New, and then click Distribution List.  

2. In the Name box, type the name of your distribution list. (For example, "Political 
Friends.")  

3. On the Distribution List tab, click Select Members.  

4. In the Address Book drop-down list, click the address book that contains the e-
mail addresses you want to include in your distribution list. 

   

5. In the Search box, type a name that you want to include. When the name you're 
searching for appears in the list below, click it, and then click Members.  

6. Do this for each person whom you want to add to the distribution list, and then click 
OK.  

Note If you want to add a longer description of the distribution list, on the 
Distribution List tab, click Notes, and then type the text. The distribution list is saved 
in your Contacts folder under the name that you give it. 

Create a distribution list by copying names from an e-mail message 

1. In the message that you want to copy the names from, select the names in the To 
or Cc box.   

2. Right-click your selection, and then click Copy on the shortcut menu.  

3. Click the Microsoft Office Button , and under Create New Outlook Item, click 
Distribution list.  

4. On the Distribution List tab, in the Members group, click Select Members.  

5. At the bottom of the Select Members dialog box, in the Members box, right-click and 
then click Paste on the shortcut menu.  

Note A member does not need to be in your Address Book in order to be 
added to the distribution list. The member's name and e-mail address will be 
included when you copy and paste from the original e-mail message. 
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6. Click OK.  

7. In the Name box, type a name for the distribution list.  

8. On the Distribution List tab, in the Actions group, click Save & Close.  

 

Add a Distribution List Received From Someone Else To Your Contacts 

Distribution lists are stored by default in your Contacts folder. When you receive a 

distribution list from someone else, you can save it to your Contacts. 

1. Open the message that contains the distribution list.  

2. In the header of the message, right-click the distribution list, and then click Add to 
Outlook Contacts on the shortcut menu.  

 

Add or Delete a Name In a Distribution List 

Show me the names in a distribution list 

Do one of the following:  

 
1. View the names in the Address Book  

a. In a new message, click To... 

b. In the Address Book drop-down list, click the address book that contains the 
distribution list that you want information about.  

c. In the Search box, type the name of the distribution list.  

d. In the Name list, right-click the distribution list, and then click Properties on 
the shortcut menu. 

2. View the names in the header of a message or meeting request  

a. In the To... box, click the plus sign (+) next to the name of the distribution list.  

Note After the list is expanded, you cannot collapse the list again. Distribution 
lists in the E-mail field of a contact cannot be expanded. 

 
 
You can edit a distribution list by adding or deleting names 

In Contacts, open the distribution list and do one or more of the following:  

 

Note In list views, distribution lists are marked with  . 
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1. Add an address from an address book or a contacts folder 

a. On the Distribution List tab, click Select Members.  

b. In the Address Book drop-down list, click the address book that contains 
the e-mail addresses you want in your distribution list.  

c. In the Search box, type a name you want to include.  

d. In the Name list, click the name, and then click Members. Do this for each 
person whom you want to add to the distribution list, and then click OK. 

2. Add an address that is not in a contacts folder or an address book    

a. On the Distribution List tab, click Add New.  

b. Type the information for the e-mail address, and then click OK.  

Delete a name 

1. Click the name, and then click Remove 
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Unit 7 - Managing Tasks 

You are in the middle of writing a message and think of something else that needs to be 

done. You could scribble yourself a note, hoping that it doesn’t get lost in the shuffle. 

A better option is to enter the task in Outlook. You will then have an electronic 

reminder of what needs to be done and when. 

 
 
 

About Tasks and To-Do Items 

A task is an item that you create in Outlook to track 

until its completion.  

A to-do item is any Outlook item — such as a task, 

an e-mail message, or a contact — that has been 

flagged for follow-up.  

By default, all tasks are flagged for follow-up when they 

are created, even if they have no start date or due date. 

Therefore, whenever you create a task, or flag an e-mail 

message or a contact, a to-do item is created 

automatically. 

When you need to quickly indicate that an item 

requires your attention at a later time, flagging is the 

best option.  

When you flag an item, it is displayed with a flag in the Mail view, in Tasks, in the 

To-Do Bar, and in the Daily Task List in Calendar.  

Flagging a message or contact does not create a new task. Because the to-do item 

is still an e-mail message or contact after being flagged, you do not have the ability to 

assign it as a task to someone else, or indicate its progress or percentage of 

completeness.  
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A task can occur once or repeatedly. A task can repeat at regular intervals, or it can 

repeat based on the date that you mark the task complete. For example, you can create 

a recurring task to send a status report to your manager on the last Friday of every 

month, or create a recurring task to get a haircut one month after your last one. 

Both tasks and to-do items appear in Tasks, in the To-Do-Bar, and in the Daily 

Task List in Calendar. No matter which view you are in, the To-Do Bar keeps you 

informed of your calendar, task, and to-do items. 

There are several ways to create a new task in Outlook. You can use the Task 

command (click New on the File menu), enter a task in the Type a new task text box 

in the To-Do Bar from any view in Outlook, type in any blank space in the Daily Task 

List in Calendar, or click and type in the Click here to add a new Task text box at 

the top of Tasks view. Of these, the fastest way is to use the To-Do Bar. 

You can also create a task by dragging an item, such as an e-mail message, to 

Tasks in the Navigation Pane. A copy of the e-mail message is then created as a task. 

Whether you track tasks that are assigned to yourself (such as reminders to respond to 

e-mail messages), or track tasks that are assigned to other people (such as the 

progress of someone's project), Outlook tasks are your solution. You can quickly add 

and update tasks, or mark them as complete. With tasks incorporated into the Calendar 

view, you have a rich interface for keeping track not only of your appointments, but of 

the tasks that you need to complete on a given day as well. 

 

Create a Task From the File Menu 

1. On the File menu, point to New, and then click Task.  

a. Keyboard shortcut To create a new task, press CTRL+ SHIFT+ K 

2. In the Subject box, type a name for the task.  

Note You have now entered enough information to create a task. The 
following steps are optional, but will help you better manage your tasks in Outlook. 

3. On the Task tab, in the Actions group, click Save & Close or continue with the 
following steps to customize your task.  

4. If you want, set the Start date and the Due date for the task.  
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Note If you specify a Start date, the Due date field is automatically set to the 
same day. You can change the Due date field to any date that you want. 

5. If you want to make the task recur, on the Task tab, in the Options group, click 
Recurrence.  

6. In the Task Recurrence dialog box, click the frequency (Daily, Weekly, Monthly or 
Yearly) with which the task should recur, and then do one of the following:  

a. Make the task recur based on a regular interval   In the Recurrence pattern 
section, select the options for the frequency interval that you want. Do not 
select Regenerate new task, or the task will not recur at regular intervals.  

b. Make the task recur based on completion date   Select Regenerate new task, 
and in the box, type the amount of time after which a new task must be 
generated.  

Each time that you mark the task complete, a new task will be created based on your 

specifications.  

Tip  This is your best choice when you do not want the next reminder for a 
task to appear until the previous one is marked as complete. If you do not mark the 
item complete, the next reminder will never appear. For example, if you have a 
reminder to pay your utility bill on the 15th of each month and you do not mark the 
occurrence on April 15th as complete, in May you will still see the not yet 
completed April 15th task. Only after you mark the April 15th task as complete does 
the May 15th occurrence of the task appear. 

7. Click OK to close the Task Recurrence dialog box.  

8. If you want to add a reminder alert, select the Reminder check box, and then enter 
the date and time for the reminder.  

9. You can specify a custom sound to be played with your reminder. Click , click 
Browse, select the sound file to play, click Open, and then click OK. This changes the 
reminder sound only for this task.  

10. If you want to track your progress on this task, in the Status, Priority, and % 
Complete boxes, enter the values that you want.  

 

Note The 'Status' and '% Complete' fields are linked and when you change 
the value in either field, the value in the other field changes accordingly.  
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Status % Complete 

Not Started 0 

In Progress 1-99 

Completed 100 

Waiting on someone else 0-100 

Deferred 0-100 

  

11. If you want to assign a colour category to your task, on the Task tab, in the 
Options group, click Categorise, and then click one of the colour categories on the 
menu. For more colour categories, click All Categories.  

 The first time that you use a colour category, you are prompted to provide a name for 

the colour category that is more meaningful to you.  

 You can create custom colour categories, associate custom colours with the colour 

categories, and assign shortcut keys to the colour categories. Click OK to return to 

the Task window. 

Tip  Changed your mind about a colour category assignment? Right-click 
the colour or name of the colour category, then click Clear Name of Category or 
Clear All Categories. 

 
12. If your task involves a person or organization in your Contacts, you can create a 

quick link to the contact, by clicking Contacts at the bottom of the window, and then 
selecting an entry. Click OK to close the Select Contacts dialog box.  

Note By default, Contacts linking does not appear on the message, contacts, 
and tasks windows. To turn on Contact linking, on the Task tab, in the Actions 
group, click Save & Close. On the main Outlook window, on the Tools menu, click 
Options. On the Preferences tab, click Contact Options, and then on the Contact 
Options dialog box under Contact Linking, select the Show Contact Linking on all 
Forms check box. Open your task to continue with this procedure. 

13. If you do not want other people to see a shared task entry, on the Task tab, in the 
Options group, click Private.  

14. If you want to enter mileage, work hours, and other billing information, on the Task 
tab, in the Show group, click Details. Type the information in the Total work, Actual 
work, Mileage, and Billing information text boxes. 

15. On the Task tab, in the Actions group, click Save and Close.  
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Create a Task or a To-Do Item From an E-Mail Message 

There are several ways to turn an e-mail message into a task or a to-do item. 

Do any of the following: 

 Flag an e-mail message for follow-up  

Flagging a message is the best option when you need to quickly mark an item for your 

attention at a later time. When you flag an item, it is displayed in the Mail view with a 

flag, in Tasks, in the To-Do Bar, and in the Daily Task List in Calendar.  

Flagging a message or contact does not create a new task. Because the to-do item still 

remains an e-mail message or contact after being flagged, you do not have the ability to 

assign it as a task to someone else, or indicate its progress or percentage of 

completeness. 

 
1. In Mail, right-click the flag column for an e-mail message.  

2. Choose the due date.  

 

Tip  To add a follow-up flag quickly, click the flag column next to the e-mail 
message. A start date and due date of today are set automatically. 

 

Note To change the reminder time, reminder sound, Start date, Due date, or 
the flag text that appears in the InfoBar, or to clear the reminder flag, right-click the 
flag column next to the e-mail message, and then click Custom or Add Reminder. 
Both options open the same dialog box, but when you use Add Reminder, the 
reminder check box is selected automatically. 
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 Drag an e-mail message to the To-Do Bar to create a to-do item. 

Note The To-Do Bar must be arranged by Start Date or Due date to use 
these procedures. 

1. Click an e-mail message to select it, and then drag the message to the task list 
section of the To-Do Bar.  

2. When you see a red line with arrows at each end positioned where you want to place 
the task, release the mouse button.  

 

 

 Drag an e-mail message to the Tasks button to create a new task. 

When you drag an e-mail message to Tasks in the Navigation Pane, you can use all of 

the features of a task item, and the contents of the e-mail message, except attachments, 

are copied to the body of the task. Even if the original e-mail message is later deleted, 

the task, including the copied contents, except attachments, of the e-mail message, is 

still available. 

 
1. Click an e-mail message to select it, and then drag it to the Task button on the 

Navigation Pane.  

Tip  To add the message as an attachment to the task instead of pasting the 
text into the task body, right-click the message and drag it to the task list. On the 
shortcut menu, click Copy Here as Task with Attachment. 

 
2. A new task item window appears, and a copy of the e-mail contents is pasted into 

the task body. The subject of the e-mail message becomes the subject of the task. If 
you want, you can change the subject. 

Note You have now entered enough information to create a task. The 
following steps are optional, but will help you better manage your tasks in Outlook. 
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3. On the Task tab, in the Actions group, click Save & Close or continue with the 
following steps to customize your task.  

4. If you want, set the Start date and the Due date for the task.  

Note If you specify a Start date, the Due date field is automatically set for the 
same day. You can change the Due date to a date that you want. 

 
 
FOLLOW THE STEPS AS ABOVE TO….. 

Create a To-Do Item From a Contact 

Flagging a contact is the best option when you need to quickly mark a contact for 

your attention at a later time.  

Flagging a contact creates a to-do item, with the text of the flag in the InfoBar. The flagged 

contact is also displayed in the Tasks list, To-Do Bar, and in the Calendar Daily Task List. 

Flagging a contact does not create a new task item. Because the to-do item still remains a 

contact, you do not have the ability to assign it as a task to someone else, or to indicate its 

progress or percentage complete. 

1. In Contacts, right-click the contact.  

2. Point to Follow Up on the shortcut menu, and then click the due date.  

Tip  To change the reminder time, reminder sound, Start date, Due date, or 
the flag text that appears in the InfoBar, or to clear the reminder flag, click Custom 
or Add Reminder. (Both options open the same dialog box, but when you use Add 
Reminder, the reminder check box is selected automatically.) 

 

Create a task in the To-Do Bar 

The To-Do Bar appears in all Outlook views by default. You can turn the To-Do Bar 

on or off. In addition, you can choose to display a minimized version of the To-Do Bar, 

which uses less screen space. When you turn the To-Do Bar on or off, or minimize it in 

a specific view, the setting applies only to that view. For example, if you turn off the To-

Do Bar in the Mail view, it will remain off each time you are in the Mail view, including 

the next time you start Outlook. However, it remains on in other views such as 

Calendar, Notes and Tasks. 
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To toggle the To-Do bar on or off, click View, point to To-Do Bar, and then click 

Normal, Minimized, or Off.  

1. To create a new task in the To-Do Bar, click in the Type a new task text box 
(called the Task Input Panel, type a subject for the task, and then press ENTER.  

 

By default, the task will be assigned a due date and a start date, that are based 

upon the flag's Set Quick Click setting. When you first install Outlook, this setting is 

configured as Today. 

If you create a task and change the flag to another Due date choice, any future tasks 

that you enter in the To-Do Bar will use the new setting. You can always override the 

choice that is displayed and pick another option. However, when you restart Outlook, 

the first task entered will default to the Set Quick Click flag setting. 

Tip  To change the default flag setting, right-click the flag column in any 
view, click Set Quick Click, and then choose the flag setting that you want. The 
options include No Date. Choosing the No Date flag makes the item appear in the 
No Date group in the To-Do Bar. 

Note You have now entered enough information to create a task. The 
following steps are optional, but will help you better manage your tasks in Outlook. 

1. Continue with the following steps to customize your task by double-clicking the task 
in the To-Do Bar.  

2. If you want, set the Start date and the Due date for the task.  

3. If you specify a Start date, the Due date field is automatically set for the same day. 
You can change the Due date to a date that you want. 

FOLLOW THE STEPS AS ABOVE TO…. 

Create a Task In The Daily Task List in Calendar 

The Daily Task List appears only in the Outlook Calendar day and week views. To 

toggle the Daily Task List on or off, in Calendar, click View, point to Daily Task List, and 

then click Normal, Minimized, or Off. 
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To display only the total number of tasks, do one of the following: 

 In Calendar, click View, point to Daily Task List, and then click Minimized.  

 Point to the top edge of the Daily Task List. When the pointer becomes a , drag 

the edge to the bottom of the window.  

Tip To create new tasks in the Daily Task List, you must use the Normal Daily Task 
List setting. 

 
1. In the Daily Task List, as your pointer hovers, Click to add task is displayed.  

2. Click any blank space beneath a day column.  

3. Type a subject for the task, and then press ENTER.  

By default, the task will be assigned a Start date and Due date of the day in the column 

above the Daily Task List. In order to change the Start date or Due date of the task, you 

can drag the created task to the day that the task is due. Alternatively, instead of dragging 

the task, you can open the task and then change the start and due dates. To do so, you 

can right-click the task, and then click Open, or select the item, press ESC, and then 

press ENTER. 

4. If you want to make the task recur, on the Task tab, in the Options group, click 
Recurrence.  

FOLLOW STEPS AS ABOVE TO…. 

Complete a Task 

When you have completed a task or no longer need to follow up on an item, you can mark 

it complete. After it is marked complete, it will no longer display as an active task in 

Microsoft Office Outlook 
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Do any of the following: 

 Click the flag status column in the message list, in Tasks, in the To-Do Bar, or in 

the Daily Task List in Calendar  

• Click the flag status column beside the item.  

 Right-click the task in Tasks, in the To-Do Bar, or in the Daily Task List in Calendar 

• Right-click the task.  

• Click Mark Complete on the shortcut menu.  

 Double-click the task in Tasks 

• Double-click the task to open it.  

• In the % Complete box, enter 100%.  

The Status and % Complete fields are linked. If you change the value in one field, the 

value in the other field also changes, according to the values in the following table.  

Status % Complete 

Not Started 0 

In Progress 1-99 

Completed 100 

Waiting on someone else    0-100 

Deferred 0-100 

Note If the Complete field appears in the task list — as a column of check 
boxes headed by a check mark — you can select the check box for the task to 
mark it complete. If the Status field appears in the task list, you can click Completed 
in the drop-down list for the task. 

Open an e-mail message marked with the task flag 

1. Open the e-mail message.  

2. On the Message tab, in the Tracking group, click .  

a. Keyboard shortcut ALT + U 

3. Click Mark Complete. 



   

 

Best STL ©2013 www.microsofttraining.net 64 

 0207 987 3777 

 

Difference between ‘Mark Complete’ AND ‘Clear Flag’ 

 Mark Complete  The item remains marked with a follow-up flag, but it is now 

displayed with a strikethrough. If the To-Do Bar or Tasks is configured to show all 

tasks and to-do items regardless of whether or not they are complete, you will 

continue to see the message until you delete it from your mail folders. 

 Clear Flag  The flag is removed from the e-mail message, and there is no record 

of the message ever appearing in the To-Do Bar and Tasks. 

If you want to keep a record of completed items, use Flag Complete. However, once you 

delete the e-mail message, the entire item will completely disappear from all Outlook 

views 

 

Skip an Occurrence of a Recurring Task 

1. Open the specific occurrence that you want to skip.  

2. On the Task tab, in the Options group, click Skip Occurrence.  

Note If you set the recurring task to end after a specified number of 
occurrences, each occurrence you skip reduces the number of remaining 
occurrences by one. 

End Recurrence of a Task 

1. Open the recurring task.  

2. On the Task tab, in the Options group, click Recurrence.  

3. Click Remove Recurrence.  


